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Safety Notices

A CAUTION notice denotes a hazard.
It calls attention to an operating
procedure, practice, or the like that,
if not correctly performed or
adhered to, could result in damage
to the product or loss of important
data. Do not proceed beyond a
CAUTION notice until the indicated
conditions are fully understood and
met.

A WARNING notice denotes a
hazard. It calls attention to an
operating proced ure, practice, or
the like that, if not correctly
performed or adhered to, could
result in personal injury or death.
Do not proceed beyond a WARNING
notice until the indicated
conditions are fully understood and
met.
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100GBASE-KR4 Compliance Test Application—At a Glance

Required
Equipment and
Software

TIP

Keysight N8829A T00GBASE-KR4 Compliance Test Application Methods of Implementation

The Keysight N8829A T00GBASE-KR4 Compliance Test Application is an Ethernet
test solution that covers the electrical timing parameters for T00GBASE-KR4
specification (IEEE 802.3bj D3p0).
The TOOGBASE-KR4 Compliance Test Application:

Lets you select individual or multiple test to run.

Lets you identify the device being tested and its configuration.

Shows you how to make oscilloscope connections to the device under test.

Automatically checks for proper oscilloscope configuration.

Automatically sets up the oscilloscope for each test.

Allows you to determine the number of trials for each test.

Provides detailed information of each test that has been run. The result of
maximum 64 worst trials can be displayed at any one time.

Creates a printable HTML report of the tests that have been run. This report
includes pass/fail limits, margin analysis, and screen shots.
In order to run the TOOGBASE-KR4 automated tests, you need the following
equipment and software:

For the minimum version of Infiniium oscilloscope software, see the N8829A
release notes.

N8829A T00GBASE-KR4 Compliance Test Application software and license.
For differential probing (minimum 25 GHz):

These can be used as an option, but will be BW limited. Instead, it is recommened to test with
cables on the Real Edge channels.

N2802A 25 GHz InfiniiMax Il Series probe amplifier.

N2803A 30 GHz InfiniiMax Ill Series probe amplifier.

N2836A InfiniiMax Il 26 GHz solder-in probe head.
For single-ended probing:

SMA cables that are able to support the 25 Gb speed.
Infiniilum oscilloscope:

DSA-X 90000 Q-Series oscilloscope.

DSO-X 90000 Q-Series oscilloscope.
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Installing the N8829A
Compliance Test Application

Installing the Software / 8
Installing the License Key / 9

If you purchased the N8829A Compliance Test Application separate from your
Infiniilum oscilloscope, you need to install the software and license key.



1 Installing the N8829A Compliance Test Application

Installing the Software

1 Make sure you have the minimum version of Infiniium oscilloscope software
(see the N8829A release notes) by choosing Help > About Infiniium... from the
main menu.

2 To obtain the N8829A Compliance Test Application, go to Keysight website:
http://www.keysight.com/find/N8829A

3 The link for N8829A TO0GBASE-KR4 Compliance Test Application will appear.
Double-click on it and follow the instructions to download and install the
application software.
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Installing the N8829A Compliance Test Application 1

Installing the License Key

1 Request a license code from Keysight by following the instructions on the
Entitlement Certificate.

You will need the oscilloscope's "Option ID Number", which you can find in the
Help > About Infiniium... dialog.

2 After you receive your license code from Keysight, choose Utilities > Install Option
License....

3 Inthe Install Option License dialog, enter your license code and click Install
License.

4 Click OK in the dialog that tells you to restart the Infinilum oscilloscope
application software to complete the license installation.

5 Click Close to close the Install Option License dialog.
6 Choose File > Exit.

7 Restart the Infiniium oscilloscope application software to complete the license
installation.
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1 Installing the N8829A Compliance Test Application
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Preparing to Take
Measurements

Calibrating the Oscilloscope / 12
Starting the Compliance Test Application / 13

Before running the automated tests, you should calibrate the oscilloscope and
probe. No test fixture is required for this application. After the oscilloscope and

probe have been calibrated, you are ready to start the N8829A Compliance Test
Application and perform the measurements.

1



2 Preparing to Take Measurements

Calibrating the Oscilloscope

If you haven't already calibrated the oscilloscope, see Appendix A, “Calibrating the
Infinilum Oscilloscope and Probe,” starting on page 57.

If the ambient temperature changes more than 5 degrees Celsius from the calibration
temperature, internal calibration should be performed again. The delta between the
calibration temperature and the present operating temperature is shown in the Utilities >
Calibration menu.

If you switch cables between channels or other oscilloscopes, it is necessary to perform cable
and probe calibration again. Keysight recommends that, once calibration is performed, you
label the cables with the channel on which they were calibrated.
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Preparing to Take Measurements

Starting the Compliance Test Application

1 Ensure that the Device Under Test (DUT) is operating and set to desired test

modes.

2 To start the Compliance Test Application: From the Infinilum oscilloscope's
main menu, choose Analyze > Automated Test Apps > N8829A 100GBASE-KR4 Test

App.

File View Tools Help

2

0w | e @ 5E I |

Task Flow

SetUp
Select Tests

SetUp |SelectTests I Configure I Connectl Run Tests I Automation I Results I Html Reportl

Test Environment Setup

—Device Under Test (DUT)

—M ement O pion

* 100GBASE-KR4

Multi-Lane Option
% Switch Matrix
" Four Diff Probe Pairs

' Real Edge
" Channels 1and 3
" Channels 2 and 4

—Scope Channel Pair——

" Single Lane

Switch Matrix Setup |

—TestReportC ni= (Optional)
Device |dentifier: User Description:
|SELECTORTYPE)  ~|  [ISELECTORTYFE)  ~|
Comments:
o Saved Waveform
InfiniiSim Setup Set Channel skew | Sy
No Device Connected PNA ] Connect PNAENA |
| 0 Tests |Fo||ow instructions to describe your test environment Connection: UNKNOWN "

Figure1  N8829A Compliance Test Application Main Window

The task flow pane, and the tabs in the main pane, show the steps you take in
running the automated tests:
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2 Preparing to Take Measurements

Set Up Lets you identify and set up the test environment, including information
about the device under test.

The Device Identifier, User Description, and Comments are all printed in
the final HTML report.

Set up InfiniiSim with the InfiniiSim Setup button.

With the Set Channel skew button, the channels can be visually adjusted
and skewed.

The Saved Waveform Setup button enables easy setup of saved
waveforms. When waveforms are set up, the application will make all
measurements on the saved waveforms.

The Multi-Lane Option enables you to choose to test a single lane or with
the switch matrix.

Select Tests Lets you select the tests you want to run. The tests are organized
hierarchically so you can select all tests in a group. After tests are run,
status indicators show which tests have passed, failed, or not been run,
and there are indicators for the test groups.

Configure Lets you configure test parameters (for example, channels used in test,
Number of Ul to test, scope band width, etc.).

Connect Shows you how to connect the oscilloscope to the device under test for
the tests that are to be run.

Run Tests Starts the automated tests. If the connections to the device under test
need to be changed while multiple tests are running, the tests pause, show
you how to change the connection, and wait for you to confirm that the
connections have been changed before continuing.

Automation Lets you construct scripts of commands that drive execution of the
application.
Results Contains more detailed information about the tests that have been run. You

can change the thresholds at which marginal or critical warnings appear.

HTML Report Shows a compliance test report that can be printed.
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Probing and
Connection for the
Bus Signal Level
Tests

Test Procedure

Keysight N8829A T00GBASE-KR4 Compliance Test Application
Methods of Implementation

Main Voltage Measurements

Differential Peak-to-Peak Output Voltage Test with TX Disabled / 17
DC Common Mode Output Voltage Test / 18

AC Common Mode Output Voltage Test / 19

Differential Peak-to-Peak Output Voltage Test / 20

This section provides the Methods of Implementation (MOls) for the
100GBASE-KR4 Main Voltage Measurements using a Keysight Infiniium
oscilloscope and the N8829A Compliance Test Application.

- —
TP1 Eo ©© 059
| -
DUT+ |

Transmitter
Under Test

DUT-

Figure2  Probing for Main Voltage Measurements

You can use any of the oscilloscope channels as the signal source channel;
however, for proper BW, use the Real Edge channels. Select lane options in the
Setup tab. You can identify the channels used for the measurement signal in the

Setup tab of the Compliance Test Application.

1 Start the automated test application as described in "Starting the Compliance

Test Application" on page 13.
2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope

that you have set up in the Configuration tab.

4 In the Test application, click the Set Up tab. Select Measurement Option, Lane

Option, and Channels.
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3

16

Main Voltage Measurements

Main Voltage
Specifications

5 Set up Switch matrix (if used) by clicking on the Switch Matrix Setup button.
6 Setup InfiniiSim if needed.

7 Type in or select the Device Identifier as well as the User Description from the
drop-down list. Enter your comments in the Comments text box.

8 Click the Select Tests tab and check the tests you want to run. Check the parent
node or group to check all the available tests within the group.

File View Tools Help
D d| 51 |[@ B0

Task Flow _| setup SelectTests |Conﬁgure I Connectl Run Tests I Automation I Results I Html Report

—
SetU E|D ) 100GBASE-KR4 Tests
z =[] © Main Voltage Measurements (pattern: PRESS)
----- [@ ] Differential Peak to Peak Output Voltage Test with TX disabled

) DC Common Mode Output Voltage Test
) AC Common Mode Output Voltage Test
-] 0 Differential Peak to Peak Output Voltage Test
=[] © Jitter and Signaling Rate Measurements (pattern: PRBSS)
----- []© signaling Rate
----- [0 © Even-Odd Jitter
----- [] © Bounded Uncorrelated Jitter
----- []© Random Jitter
=[] © Output Waveform Measurements {pattern: PRESS)
----- [0 © Steady-State Voltage Vf
----- [ Linear Fit Pulse Peak
B[] © Mormalized Coefficient Step Size
B[] © Full Scale Range Tests
=[] Return Loss PNA/ENA Measurements
-[[] © Differential Qutput Return Loss
-[]© Common-mode Output Return Loss
=[] © DME/EEE Waveform Measurements
----- [] © DME Differential Peak to Peak Output Voltage Test
----- [] © DME T1-Transition Position Spacing (period) Test
----- [] © DME T2-Clock Transition to Clock Transition Test
----- [] © DME T3-Clock Transition to Data Transition Test
----- [[] © EEE Differential Peak to Peak Output Voltage Test with TX disabled
----- [] © EEE Differential Peak to Peak Output Voltage Test
----- [] © EEE Common Mode Voltage Deviation Test

Select Tests

Test: Differential Peak to Peak Output Voltage Test with TX disabled

Pass Limits: Differential Voltage Tx disable <= 30.00 mV -
Description: Test the maximum voltage with the TX disabled

Limit Set: IEEE 802.3 100GBASE-KR.4 Test Limit EI
Reference: 802.3bj D2.2 Spec - Section 93.8.1.7 Table 93-4

| 4 Tests |Ched< the test(s) you would like to run |Connecﬁon: UNKMOWN | 4

Figure 3  Selecting Main Voltage Measurement Tests

The TOOGBASE-KR4 specifications can be found in IEEE 802.3 section 93.8.1.
Differential Peak-to-Peak Output Voltage with TX disabled (max 30 mV).
DC Common Mode Output Voltage (0-1.9 V).

AC Common Mode Output Voltage (max 12 mV).
Differential Peak-to-Peak Output Voltage (max 1200 mV).
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Main Voltage Measurements

Differential Peak-to-Peak Output Voltage Test with TX Disabled

The purpose of this test is to verify that when TX is disabled the peak-to-peak
voltage is less than 30 mV.

PASS Condition  The max peak-to-peak voltage is less than 30 mV.

Measurement
Algorithm

1
2
3
4

Obtain sample or acquire signal data.

Check that the signal is truly with TX disabled (no valid data transitions).
Measure peak-to-peak voltage of the signal.

Compare the max peak-to-peak voltage to 30 mV.

Keysight N8829A TO0GBASE-KR4 Compliance Test Application Methods of Implementation
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3

Main Voltage Measurements

DC Common Mode Output Voltage Test

18

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the common mode signal of the differential
pair is between 0-1.9 V.

This measurement can be done only with dual-single ended connection; it cannot be done
with a differential probing connection.

The signal is between 0-1.9 V.

1 Obtain sample or acquire signal data.
2 Verify that there is a signal and that the connection is dual-single ended.

3 Measure the peak-to-peak voltage of the addition of the channel 1 and 3 or
channel 2 and 4.

4 Compare the voltage measurement to 0-1.9 V.

Keysight N8829A TO0GBASE-KR4 Compliance Test Application Methods of Implementation



Main Voltage Measurements 3

AC Common Mode Output Voltage Test

The purpose of this test is to verify that the common mode signal of the differential
pair rms voltage does not exceed 12 mV.

This measurement can be done only with dual-single ended connection; it cannot be done
with a differential probing connection.

PASS Condition  The signal is less than 12 mV.

Measurement 1 Obtain sample or acquire signal data.
Algorithm 5 \/grify that there is a signal and that the connection is dual-single ended.

3 Measure the peak-to-peak voltage of the addition of the channel 1 and 3 or
channel 2 and 4.

4 Compare the voltage measurement to 12 mV.
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3

Main Voltage Measurements

Differential Peak-to-Peak Output Voltage Test

20

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the peak-to-peak voltage of the differential
signal on a PRBS9 pattern is less than 1200 mV.

The differential signal max peak to peak voltage on a PRBS9 pattern is less than
1200 mV.

1
2
3
4

Obtain sample or acquire signal data.

Verify that there is a signal is connected and has a PRBS9 pattern.

Measure the peak-to-peak voltage of the differential signal of DUT+ and DUT-.
Compare the max peak-to-peak voltage to 1200 mV.
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4

Probing and
Connection for the
Bus Signal Level
Tests

Test Procedure

Keysight N8829A T00GBASE-KR4 Compliance Test Application
Methods of Implementation

Jitter and Data Rate
Measurements

Data Rate / 23
Jitter (Even-0dd Jitter, Bounded Uncorrelated Jitter, Random Jitter) / 24

This section provides the Methods of Implementation (MOls) for the Jitter and
Data Rate Measurements using a Keysight Infiniium oscilloscope and the N8829A
100GBASE-KR4 Compliance Test Application.

Transmitter
Under Test

- —

TP1 Eo ©© 059
] -

DUT+ ”

DUT-

Figure 4  Probing for Jitter and Data Rate Measurements

You can use any of the oscilloscope channels as the signal source channel;
however, for proper BW, use the Real Edge channels. Select lane options in the
Setup tab. You can identify the channels used for the measurement signal in the
Setup tab of the Compliance Test Application.

1 Start the automated test application as described in "Starting the Compliance
Test Application" on page 13.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope
that you have set up in the Configuration tab.
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4 Jitter and Data Rate Measurements

4 In the Test application, click the Set Up tab. Select Measurement Option, Lane
Option, and Channels.

5 Set up Switch matrix (if used) by clicking on the Switch Matrix Setup button.
6 Setup InfiniiSim if needed.

7 Type in or select the Device Identifier as well as the User Description from the
drop-down list. Enter your comments in the Comments text box.

8 Click the Select Tests tab and check the tests you want to run. Check the parent
node or group to check all the available tests within the group.

File View Tools Help
D d| 51 |[@ B0

Task Flow _| setup SelectTests |Conﬁgure I Connectl Run Tests I Automation I Results I Html Report
e

SetU E|D ) 100GBASE-KR4 Tests
z =[] © Main Voltage Measurements (pattern: PRESS)

----- [] © Differential Peak to Peak Output Voltage Test with TX disabled
----- []© DC Common Mode Output Voltage Test

----- []© AC Common Mode Output Voltage Test

----- [ © Differential Peak to Peak Output Voltage Test

E-[¥] © Jitter and Signaling Rate Measurements (pattern: PRBSS)

Select Tests

=[] © Output Waveform Measurements {pattern: PRESS)
----- [0 © Steady-State Voltage Vf
----- [ Linear Fit Pulse Peak

-] © Normalized Coefficient Step Size
E-[J] O Full Scale Range Tests
B[] © Return Loss PNA/ENA Measurements
-[] O Differential Output Return Loss
[ © Common-mode Output Return Loss
=[] © DME/EEE Waveform Measurements
[] © DME Differential Peak to Peak Output Voltage Test
) DME T1-Transition Position Spacing (period) Test
J DME T2-Clock Transition to Clock Transition Test
J DME T3-Clock Transition to Data Transition Test
) EEE Differential Peak to Peak Output Voltage Test with TX disabled
) EEE Differential Peak to Peak Output Voltage Test
) EEE Common Mode Voltage Deviation Test

Test: Signaling Rate

Pass Limits: 25, 778671875 Gbps <= Signaling Rate <= 25.783828125 Gbps -
Description: Signaling rate of the signal E
Limit Set: IEEE 802.3 100GBASE-KR.4 Test Limit

Reference: 802.3bj D2.2 Spec - Section 93.8.1.7 Table 93-4

Wl 4Tests |Check the test(s) vou would ke torun |Connection: UNKNOWN | A

Figure 5  Selecting Jitter and Data Rate Tests

Transmitter Output  The 40GBASE-CR4 and T00GBASE-CR10 specifications can be found in IEEE
Waveform  802.3 section 93.8.1.

Specifications . pata Rate (25.78125 +/- 100ppm GBd).
Max output jitter.
Even-0dd Jitter (max 35 mUl).
Bounded Uncorrelated Jitter (max 100 mUl).
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Jitter and Data Rate Measurements 4

Random Jitter (max 10 mUlI).
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4

Jitter and Data Rate Measurements

Data Rate

24

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the data rate mean is between 25.78125
+100 ppm GBd.

The mean data rate is between 25.78125 +100 ppm GBd.

1

N

N oo g &~ W

Obtain sample or acquire signal data.

Check that signal is connected and data pattern exists (PRBS9 must be used
for this test).

Set memory depth to capture the number or Ul set in the configuration tab.
Set data rate measurement to semi-automatic 25.78125 Gb/s.

Measure min, max, mean data rate.

Report min and max values.

Compare and report the mean data rate value to 25.78125 +100 ppm GBd.
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Jitter and Data Rate Measurements 4

Jitter (Even-0dd Jitter, Bounded Uncorrelated Jitter, Random Jitter)

The purpose of this test is to verify that differential signal's Even-0dd Jitter is less
that 35 mUI, Bounded Uncorrelated Jitter is less than 100 mUI, and Random Jitter
is less than 10 mUI. If all tests are selected, all tests are run on a single
measurement. Each test can be run individually by selecting any or some of the
tests.

PASS Conditions - Even-0dd Jitter is less than 35 mUI.
BUJ is less than 100 mUI.
Random Jitter rms is less than 10 mUI.

Measurement 1 Obtain sample or acquire signal data.
Algorithm

N

Check that signal is connected and data pattern exists (PRBS9 must be used
for this test).

3 Set memory depth to capture the number or Ul set in the configuration tab.

4 Set clock recovery to OJTF First Order PLL with Nominal Data Rate
25.78125 Gb/s and Loop Bandwidth to 10 MHz.

5 Using EZJIT, measure Even-0dd Jitter, BUJ, and Rj at BER of 10E-12.
6 Compare and report the values to their respective maximum specification.
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Probing and
Connection for the
Bus Signal Level
Tests

Test Procedure

Keysight N8829A T00GBASE-KR4 Compliance Test Application
Methods of Implementation

Transmitter Output Waveform
Measurements

Steady State Voltage Vf / 27
Linear Fit Pulse Peak / 28

This section provides the Methods of Implementation (MOls) for the Transmitter
Output Waveform Measurements for Transition Time using a Keysight Infiniium
oscilloscope and the N8829A T00GBASE-KR4 Compliance Test Application.

Transmitter
Under Test

- —

TP1 Eo ©© 059
] -

DUT+ W

DUT-

Figure 6  Probing for Transmitter Output Waveform Measurements

You can use any of the oscilloscope channels as the signal source channel;
however, for proper BW, use the Real Edge channels. Select lane options in the
Setup tab. You can identify the channels used for the measurement signal in the
Setup tab of the Compliance Test Application.

1 Start the automated test application as described in "Starting the Compliance
Test Application" on page 13.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope
that you have set up in the Configuration tab.
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5  Transmitter Output Waveform Measurements

4 In the Test application, click the Set Up tab. Select Measurement Option, Lane
Option, and Channels.

5 Set up Switch matrix (if used) by clicking on the Switch Matrix Setup button.
6 Setup InfiniiSim if needed.

7 Type in or select the Device Identifier as well as the User Description from the
drop-down list. Enter your comments in the Comments text box.

8 Click the Select Tests tab and check the tests you want to run. Check the parent
node or group to check all the available tests within the group.

File View Tools Help
D@ 20 |@sle
Task Flow _| setup SelectTests |Conﬁgure I Connectl Run Tests I Automation I Results I Html Report

—
B[] 100GBASE-KRA Tests
EIL-_| ) Main Voltage Measurements (pattern: PRESS)
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----- []© DC Common Mode Output Voltage Test
----- []© AC Common Mode Output Voltage Test
----- [ © Differential Peak to Peak Output Voltage Test
=[] © Jitter and Signaling Rate Measurements (pattern: PRBSS)
----- []© signaling Rate
----- [0 © Even-Odd Jitter
Configure & . [] © Bounded Uncorrelated Jitter
----- []© Random Jitter
=[] © Output Waveform Measurements {pattern: PRESS)
bl Steady-State Voltage V|
Connect | § ¢ ) Linear Fit Pulse Peak
-] © Normalized Coefficient Step Size
E-[J] O Full Scale Range Tests
B[] © Return Loss PNA/ENA Measurements
-[[] © Differential Qutput Return Loss
-[]© Common-mode Output Return Loss
) DME/EEE Waveform Measurements
-[[] © DME Differential Peak to Peak Output Voltage Test
-[[] © DME T1-Transition Position Spacing (period) Test
<[] © DME T2-Clack Transition to Clock Transition Test
-[[] © DME T3-Clack Transition to Data Transition Test
-[[] © EEE Differential Peak to Peak Output Voltage Test with TX disabled
-[[] © EEE Differential Peak to Peak Output Voltage Test
[] © EEE Common Mode Voltage Deviation Test

SetUp

Select Tests

Run Tests

Test: Steady-State Voltage WV

Pass Limits: 400 mV <= Steady-State Voltage Vf <= 600 mV -
Description: Steady-State Voltage Vf measurement E
Limit Set: IEEE 802.3 100GBASE-KR.4 Test Limit

Reference: 802.3bj D2.2 Spec - Section 93.8.1.7 Table 93-4

2 Tests |Ched< the test(s) you would like to run |Connecﬁon: UNKMOWN | v
Figure 7  Selecting Transmitter Output Waveform Test

Transmitter Output  The 40GBASE-CR4 and T00GBASE-CR10 specifications can be found in IEEE
Specifications  802.3 section 93.8.1.

Steady State Voltage Vf (400-600 mV).
Linear Fit Pulse Peak (0.71 * Vf).
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Transmitter Qutput Waveform Measurements 5

Steady State Voltage Vf

The purpose of this test is to verify that the Steady State Voltage as described in
section 85.8.3.3 is between 0.4 and 0.6 V.

PASS Condition  The Steady State Voltage is between 0.4 and 0.6 V.

Measurement 1 Set memory depth to capture one full PRBS9 pattern and scale.

Algorithm 5 calculate Vf using the equations in section 85.8.3.3.5. The result value is the
sum of the columns in P1 (Equ 85-9).

3 Compare and report the result to 0.4-0.6 V.
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5  Transmitter Output Waveform Measurements

Linear Fit Pulse Peak

The purpose of this test is to verify that the Linear Fit Pulse as described in section
85.8.3.3 is greater than the Vf*0.71.

PASS Condition  The Linear Fit Pulse is greater than Vf*0.71.

Measurement 1 Set memory depth to capture one full PRBS9 pattern and scale.

Algorithm 5 calculate p(k) linear fit using the equations in section 85.8.3.3.5. The result
value is the max of p(k).

3 Compare and report the result to 0.71*Vf.
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Probing and
Connection for the
Bus Signal Level
Tests

KEYSIGHT

TECHNOLOGIES

Keysight N8829A T00GBASE-KR4 Compliance Test Application
Methods of Implementation

Transmitter Output Waveform
Normalized Coefficient Step
Size Measurements

inc ¢(0) hold c(-1) hold / 32
dec ¢(0) hold ¢(-1) hold / 33

Normalized Coefficient Step Size c(1
Normalized Coefficient Step Size c(1
(1
(1
(1
(1

—_— — — ~— ~— ~—

Normalized Coefficient Step Size c(1) hold c(0) inc c(-1) hold / 34

Normalized Coefficient Step Size c(1) hold c(0) dec c(-1) hold / 35

Normalized Coefficient Step Size c(1) hold c(0) hold c(-1) inc / 36
)

Normalized Coefficient Step Size c(1) hold c(0) hold c(-1) dec / 37

This section provides the Methods of Implementation (MOls) for the Transmitter
Output Waveform Normalized Coefficient Step Size Measurements using a
Keysight Infiniium oscilloscope and the N8829A Compliance Test Application.

Transmitter
Under Test

DUT-

Figure 8  Probing for Transmitter Output Waveform - Normalized Coefficient Step Size
Measurements
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30

Transmitter Output Waveform - Normalized Coefficient Step Size Measurements

Test Procedure

You can use any of the oscilloscope channels as the signal source channel;
however, for proper BW, use the Real Edge channels. Select lane options in the
Setup tab. You can identify the channels used for the measurement signal in the
Setup tab of the Compliance Test Application.

1

Start the automated test application as described in "Starting the Compliance
Test Application" on page 13.

Connect the probes to the signals on the DUT.

Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope
that you have set up in the Configuration tab.

In the Test application, click the Set Up tab. Select Measurement Option, Lane
Option, and Channels.

Set up Switch matrix (if used) by clicking on the Switch Matrix Setup button.
Set up InfiniiSim if needed.

Type in or select the Device Identifier as well as the User Description from the
drop-down list. Enter your comments in the Comments text box.

Click the Select Tests tab and check the tests you want to run. Check the parent
node or group to check all the available tests within the group.
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Transmitter Output Waveform - Normalized Coefficient Step Size Measurements

File View Tools Help

D& ||

DWEE N | ®[e

Task Flow _

SetUp

Select Tests

Configure

Connect

Run Tests

SetUp Select Tests |Conﬁgure I Connectl Run Tests I Automation I Results I Html Report

—

B[]0 100GBASE-KR4 Tests

Ell_-_l ) Main Voltage Measurements (pattern: PRESS)

----- [] © Differential Peak to Peak Output Voltage Test with TX disabled
----- []© DC Common Mode Output Voltage Test

----- []© AC Common Mode Output Voltage Test

----- [ © Differential Peak to Peak Output Voltage Test

=[] © Jitter and Signaling Rate Measurements (pattern: PRBSS)

----- [1© signaling Rate

-[J© Even-Odd Jitter

-] © Bounded Uncorrelated Jitter

----- [J© Random Jitter

=[] © Output Waveform Measurements {pattern: PRESS)

----- [1© Steady-State Voltage Vf

-] © Linear Fit Pulse Peak

) Mormalized Coeffident Step Size

MNormalized Coeffident Step Size o1)inc c{0)hald c(-1)hold
Mormalized Coeffident Step Size c{1)dec c(0)hold c{-1)hold
Mormalized Coeffident Step Size c{1)hold c{0)inc cf-1)hold
Mormalized Coeffident Step Size c{1)hold c{0)dec c{-1)hold
Mormalized Coeffident Step Size c{1)hold c{0)hold c(-1)inc
Mormalized Coeffident Step Size c{1)hold c{0)hold c(-1)dec
E-[J] O Full Scale Range Tests

[J©O Return Loss PNA/ENA Measurements

[ © Differential Qutput Return Loss

-] © Common-mode Qutput Return Loss

=[] © DME/EEE Waveform Measurements

: -[[] © DME Differential Peak to Peak Output Voltage Test

-[[] © DME T1-Transition Position Spacing (period) Test

-] © DME T2-Clock Transition to Clock Transition Test

17 PME T2k Tramcitinn #n Nats Trancition Tack

=]

| »

m

Test: Normalized Coefficient Step Size c(1)inc c(0)hold c(-1)hold

Pass Limits: 8,30 mV <= Normalized Coefficent Step Size - c{1)inc,c{0)hold,c(-1)hold <= 50.00 mV
Description: Mormalized Coeffident Step Size measurement for Coefficent update c1-inc c0-hold c-1-hold
Limit Set: IEEE 802.3 100GBASE-KR.4 Test Limit

Reference: 802.3bj D2.2 Spec - Section 93.8.1.7 Table 93-4

[m] »

6 Tests |Ched( the test(s) you would like to run |Connecﬁon: UNKMOWN |

Figure 9

A

Selecting Transmitter Output Waveform - Normalized Coefficient Step Size Test

Keysight N8829A T00GBASE-KR4 Compliance Test Application Methods of Implementation
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Transmitter Output Waveform - Normalized Coefficient Step Size Measurements

Normalized Coefficient Step Size c(1) inc ¢(0) hold ¢(-1) hold

32

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the difference amplitude between
coefficient updates falls between the specified values 0.0083 and 0.05.

The difference in the coefficient update when c(1) is incremented to the previous is
within 0.0083 to 0.05.

1
2
3
4
5

© 00 N o

Request transmitter to be set to 'PRESET' condition.

Set memory depth to capture one full PRBS9 pattern and scale.
Calculate linear fit pulse response at 'PRESET' condition.
Define matrix Rm using Equation (92-4) from IEEE802.3.

Request to change the Tx setting to a Baseline condition that allows for
increment.

Calculate the coefficients defined in (92-5).

Request to change the Tx setting to increment.

Calculate linear fit pulse response.

Calculate coefficients of new waveform with equation (92-5).

10 Compare result to previous setting.

11 Loop steps 7 - 10 for as many increments to be tested.

12 Compare and report the values and verify they are in the range of 0.0083 to

0.05.
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Transmitter Output Waveform - Normalized Coefficient Step Size Measurements 6

Normalized Coefficient Step Size c(1) dec ¢(0) hold c(-1) hold

The purpose of this test is to verify that the difference in amplitude between the
coefficient updates, falls between the specified values of -0.0083 to -0.05.

PASS Condition  The difference in the coefficient update when c(1) is decremented to the previous
is within -0.0083 to -0.05.

Measurement
Algorithm

Request transmitter to be set to 'PRESET' condition.
Set memory depth to capture one full PRBS9 pattern and scale.

Define matrix Rm using Equation (92-4) from IEEE802.3.

Request to change the Tx setting to a Baseline condition that allows for
decrement.

Calculate the coefficients defined in (92-5).
Request to change the Tx setting to decrement.

1
2
3 Calculate linear fit pulse response at 'PRESET' condition.
4
5

Calculate linear fit pulse response.

© 00 N o

Calculate coefficients of new waveform with equation (92-5).
10 Compare result to previous setting.
11 Loop steps 7 - 10 for as many decrements to be tested.

12 Compare and report the values and verify they are in the range of -0.05 to
-0.0083 for dec.
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Transmitter Output Waveform - Normalized Coefficient Step Size Measurements

Normalized Coefficient Step Size ¢(1) hold c(0) inc ¢(-1) hold

34

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the difference in amplitude between the
coefficient updates falls between the specified values of 0.0083 to 0.05.

The difference in the coefficient update when c(0) is incremented to the previous
state is within 0.0083 to 0.05.

1
2
3
4
5

© 00 N o

Request transmitter to be set to 'PRESET' condition.

Set memory depth to capture one full PRBS9 pattern and scale.
Calculate linear fit pulse response at 'PRESET' condition.
Define matrix Rm using Equation (92-4) from IEEE802.3.

Request to change the Tx setting to a Baseline condition that allows for
increment.

Calculate the coefficients defined in (92-5).

Request to change the Tx setting to increment.

Calculate linear fit pulse response.

Calculate coefficients of new waveform with equation (92-5).

10 Compare result to previous setting.

11 Loop steps 7 - 10 for as many increments to be tested.

12 Compare and report the values and verify they are in the range of 0.0083 to

0.05.
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Transmitter Output Waveform - Normalized Coefficient Step Size Measurements 6

Normalized Coefficient Step Size c(1) hold c(0) dec c(-1) hold

The purpose of this test is to verify that the difference in amplitude between the
coefficient updates falls between the specified values of -0.0083 to -0.05.

PASS Condition  The difference in the coefficient update when c(0) is decremented to the previous
state is within -0.0083 and -0.05.

Measurement
Algorithm

Request transmitter to be set to 'PRESET' condition.
Set memory depth to capture one full PRBS9 pattern and scale.

Define matrix Rm using Equation (92-4) from IEEE802.3.

Request to change the Tx setting to a Baseline condition that allows for
decrement.

Calculate the coefficients defined in (92-5).
Request to change the Tx setting to decrement.

1
2
3 Calculate linear fit pulse response at 'PRESET' condition.
4
5

Calculate linear fit pulse response.

© 00 N o

Calculate coefficients of new waveform with equation (92-5).
10 Compare result to previous setting.
11 Loop steps 7 - 10 for as many decrements to be tested.

12 Compare and report the values and verify they are in the range of -0.05 to
-0.0083 for dec.
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Transmitter Output Waveform - Normalized Coefficient Step Size Measurements

Normalized Coefficient Step Size c(1) hold c(0) hold c(-1) inc

36

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the difference in amplitude between the
coefficient updates falls between the specified values of 0.0083 to 0.05.

The difference in the coefficient update when c(-1) is incremented to the previous
state is within 0.0083 and 0.05.

1
2
3
4
5

© 00 N o

Request transmitter to be set to 'PRESET' condition.

Set memory depth to capture one full PRBS9 pattern and scale.
Calculate linear fit pulse response at 'PRESET' condition.
Define matrix Rm using Equation (92-4) from IEEE802.3.

Request to change the Tx setting to a Baseline condition that allows for
increment.

Calculate the coefficients defined in (92-5).

Request to change the Tx setting to increment.

Calculate linear fit pulse response.

Calculate coefficients of new waveform with equation (92-5).

10 Compare result to previous setting.

11 Loop steps 7 - 10 for as many increments to be tested.

12 Compare and report the values and verify they are in the range of 0.0083 to

0.05.
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Transmitter Output Waveform - Normalized Coefficient Step Size Measurements 6

Normalized Coefficient Step Size ¢(1) hold c(0) hold c(-1) dec

The purpose of this test is to verify that the difference in amplitude between the
coefficient updates falls between the specified values of -0.0083 to -0.05.

PASS Condition  The difference in the coefficient update when c(-1) is decremented to the previous
state is within -0.0083 and -0.05.

Measurement
Algorithm

Request transmitter to be set to 'PRESET' condition.
Set memory depth to capture one full PRBS9 pattern and scale.

Define matrix Rm using Equation (92-4) from IEEE802.3.

Request to change the Tx setting to a Baseline condition that allows for
decrement.

Calculate the coefficients defined in (92-5).
Request to change the Tx setting to decrement.

1
2
3 Calculate linear fit pulse response at 'PRESET' condition.
4
5

Calculate linear fit pulse response.

© 00 N o

Calculate coefficients of new waveform with equation (92-5).
10 Compare result to previous setting.
11 Loop steps 7 - 10 for as many decrements to be tested.

12 Compare and report the values and verify they are in the range of -0.05 to
-0.0083 for dec.
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6  Transmitter Output Waveform - Normalized Coefficient Step Size Measurements
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Probing and
Connection for the
Bus Signal Level
Tests

Test Procedure

Keysight N8829A T00GBASE-KR4 Compliance Test Application
Methods of Implementation

Transmitter Output Waveform
- Full Scale Range
Measurements

Minimum Pre-cursor Full-scale Test / 41
Minimum Post-cursor Full-scale Test / 42

This section provides the Methods of Implementation (MOls) for the Transmitter
Output Waveform Full-Scale Range Measurements using a Keysight Infiniium
oscilloscope and the N8829A Compliance Test Application.

a
o o
o

- —
TP ESo 00 o]ﬂ
] L]
DUT+

Transmitter
Under Test

DUT-

Figure 10  Probing for Transmitter Output Waveform - Full Scale Range Measurements

You can use any of the oscilloscope channels as the signal source channel;
however, for proper BW, use the Real Edge channels. Select lane options in the
Setup tab. You can identify the channels used for the measurement signal in the
Setup tab of the Compliance Test Application.

1 Start the automated test application as described in "Starting the Compliance
Test Application" on page 13.

2 Connect the probes to the signals on the DUT.

KEYSIGHT

TECHNOLOGIES
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/  Transmitter Output Waveform - Full Scale Range Measurements

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope
that you have set up in the Configuration tab.

4 Inthe Test application, click on the Set Up tab. Select Measurement Option, Lane
Option, and Channels.

5 Set up switch matrix (if used) by clicking the Switch Matrix Setup button.
6 Setup InfiniiSim if needed.

7 Type in or select the Device Identifier as well as the User Description from the
drop-down list. Enter your comments in the Comments text box.

8 Click the Select Tests tab and check the tests you want to run. Check the parent
node or group to check all the available tests within the group.

File View Tools Help
D d| 51 |[@ B0

Task Flow _| setup SelectTests |Conﬁgure I Connectl Run Tests I Automation I Results I Html Report

—
SetU E|D ) 100GBASE-KR4 Tests
z =[] © Main Voltage Measurements (pattern: PRESS)
----- [] © Differential Peak to Peak Output Voltage Test with TX disabled

----- []© DC Common Mode Output Voltage Test
----- []© AC Common Mode Output Voltage Test
----- [ © Differential Peak to Peak Output Voltage Test
=[] © Jitter and Signaling Rate Measurements (pattern: PRBSS)
----- []© signaling Rate
----- [0 © Even-Odd Jitter
----- [] © Bounded Uncorrelated Jitter
----- []© Random Jitter
=[] © Output Waveform Measurements {pattern: PRESS)
) Steady-State Voltage Vi
) Linear Fit Pulse Peak
) Mormalized Coeffident Step Size
) Full Scale Range Tests
[@ W Minimum Pre-cursor Full-scale Range
3 Minimum Post-cursor Full-scale Range
B[] © Return Loss PNA/ENA Measurements
[] © Differential Qutput Return Loss
[]© Common-mode Output Return Loss
=[] © DME/EEE Waveform Measurements
[] © DME Differential Peak to Peak Output Voltage Test
[] © DME T1-Transition Position Spacing (period) Test
[] © DME T2-Clock Transition to Clock Transition Test
[] © DME T3-Clock Transition to Data Transition Test
[[] © EEE Differential Peak to Peak Output Voltage Test with TX disabled
+-[] ) EEE Differential Peak to Peak Output Voltage Test
“-[[] © EEE Comman Mode Voltage Deviation Test

Select Tests

Test: Minimum Pre-cursor Full-scale Range

Pass Limits: Minimum Pre-cursor Full-Scale Range == 1,540 -
Description: Minimum Pre-cursor Full-scale measurement for Coefficent c{1)minimum c{0)minimum c(-1)zero

Limit Set: IEEE 802.3 100GBASE-KR.4 Test Limit EI
Reference: 802.3bj D2.2 Spec - Section 93.8.1.7 Table 93-4

2 Tests |Ched< the test(s) you would like to run |Connecﬁon: UNKMOWN |

Figure 11  Selecting Transmitter Output Waveform - Full Scale Range Tests
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Transmitter Output Waveform - Full Scale Range Measurements /7

Minimum Pre-cursor Full-scale Test

The purpose of this test is to verify that the minimum Pre-cursor is greater than or
equal 1.54.

PASS Condition ~ When the coefficients are set to c(1) zero c(0) minimum and c(-1) minimum, the
pre-cursor full-scale ratio is greater than or equal 1.54.

Measurement 1 Request transmitter to be set to 'PRESET' condition (only if not previously have
Algorithm 'PRESET' measurement on same trial from step size).

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at 'PRESET' condition (if not previously done
in same trial on step size).

4 Define matrix Rm using Equation (92-4) from IEEE 802.3 (if not previously done
in same trial on step size).

5 Request to change the Tx setting to c(-1) zero and c(0) and c¢(1) to their
minimum values.

Calculate linear fit pulse response.

Calculate coefficients with equation (92-5).

Calculate precursor ratio (c(0) - c(1))/(c(0) + c(1)).

Report and compare the value calculated in step 8 with 1.54.

© 00 N o
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/  Transmitter Output Waveform - Full Scale Range Measurements

Minimum Post-cursor Full-scale Test

The purpose of this test is to verify that the minimum Post-cursor is greater than or
equal to 4.

PASS Condition ~ When the coefficients are set to ¢(1) minimum c(0) minimum and c(-1) zero, the
post-cursor full-scale ration is greater than or equal to 4.

Measurement 1 Request transmitter to be set to 'PRESET' condition (only if not previously have
Algorithm 'PRESET' measurement on same trial from step size).

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at 'PRESET' condition (if not previously done
in same trial on step size).

4 Define matrix Rm using Equation (92-4) from IEEE 802.3 (if not previously done
in same trial on step size).

5 Request to change the Tx setting to c(1) zero and ¢(0) and c(-1) to their
minimum values.

Calculate linear fit pulse response.

Calculate coefficients with equation (92-5).

Calculate precursor ratio (c(0) - c(1))/(c(0) + c(1)).

Report and compare the value calculated in step 8 with 4.

© 00 N o
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Keysight N8829A T00GBASE-KR4 Compliance Test Application
Methods of Implementation

8 Return Loss ENA/PNA
Measurements

Test Procedure

KEYSIGHT

TECHNOLOGIES

This section provides the Methods of Implementation (MOls) for the Return Loss
Measurements using a Keysight Infinilum oscilloscope, PNA or ENA, and the
N8829A Compliance Test Application. The Compliance test application controls
the PNA/ENA to set the test limits and run the test. The calibration must be done
on the PNA/ENA.

1

Start the automated test application as described in "Starting the Compliance
Test Application" on page 13.

Calibrate the PNA or ENA.

In the Test application, click on the Set Up tab. Select Measurement Option, Lane
Option, and Channels.

Set up switch matrix (if used) by clicking the Switch Matrix Setup button.

Type in or select the Device Identifier as well as the User Description from the
drop-down list. Enter your comments in the Comments text box.

Click the Select Tests tab and check the tests you want to run. Check the parent
node or group to check all the available tests within the group.

Press Run. The test limits are automatically calculated.
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8 Return Loss ENA/PNA Measurements

File View Tools Help

Dedl 2| ae

Task Flow _

7

tup SelectTests | configure | Connect | Run Tests | Automation | Resuits | Hemi Report |

E|D ) 100GBASE-KR4 Tests
E||_-_| ) Main Voltage Measurements (pattern: PRBSS)
----- [] © Differential Peak to Peak Output Voltage Test with TX disabled
----- []© DC Common Mode Output Voltage Test
----- []© AC Common Mode Output Voltage Test
----- [ © Differential Peak to Peak Output Voltage Test
=[] © Jitter and Signaling Rate Measurements (pattern: PRBSS)
----- []© signaling Rate
----- [0 © Even-Odd Jitter
Configure |4 | | . [] © Bounded Uncorrelated Jitter
----- []© Random Jitter
=[] © Output Waveform Measurements {pattern: PRESS)
----- [0 © Steady-State Voltage Vf
----- [ Linear Fit Pulse Peak
|23 f@ 0 Mormalized Coeffident Step Size
B[] © Full Scale Range Tests
- O Return Loss PNA/ENA Measurements
) Differential Output Return Loss
O Common-mode Output Return Loss
=[] © DME/EEE Waveform Measurements
----- [] © DME Differential Peak to Peak Output Voltage Test
----- [] © DME T1-Transition Position Spacing (period) Test
----- [] © DME T2-Clock Transition to Clock Transition Test
----- [] © DME T3-Clock Transition to Data Transition Test
----- [[] © EEE Differential Peak to Peak Output Voltage Test with TX disabled
----- [] © EEE Differential Peak to Peak Output Voltage Test
----- [] © EEE Common Mode Voltage Deviation Test

SetUp

Select Tests

Run Tests

(Click a test's name to see description)

Limit Set: IEEE 802.3 100GBASE-+R4 Test Limit

2Tests |Ched< the test(s) you would like to run |Connecﬁon: UNKMOWN | v

Figure 12 Selecting Return Loss Measurement
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Keysight N8829A T00GBASE-KR4 Compliance Test Application
Methods of Implementation

DME/EEE Waveform
Measurements

DME Differential Peak-to-Peak Output Voltage Test / 48

DME T1-Transition Position Spacing (Period) Test / 49

DME T2-Clock Transition to Clock Transition Test / 50

DME T3-Clock Transition to Data Transition Test / 51

EEE Differential Peak-to-Peak Output Voltage Test with TX Disabled / 52
EEE Differential Peak-to-Peak Output Voltage Test / 53

EEE Common Mode Deviation Voltage Test / 54

This section provides the Methods of Implementation (MQOls) for the DME and EEE
Waveform Measurements using a Keysight Infiniium oscilloscope and the N8829A
Compliance Test Application.

Probing and
Connection for the
Bus Signal Level
Tests.
Transmitter
Under Test
DUT-
Figure 13  Probing for DME/EEE Waveform Measurements
You can use any of the oscilloscope channels as the signal source channel;
however, for proper BW, use the Real Edge channels. Select lane options in the
Setup tab. You can identify the channels used for the measurement signal in the
Setup tab of the Compliance Test Application.
KEYSIGHT

TECHNOLOGIES
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DME/EEE Waveform Measurements

Test Procedure

Start the automated test application as described in "Starting the Compliance
Test Application" on page 13.

Connect the probes to the signals on the DUT.

Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope
that you have set up in the Configuration tab.

In the Test application, click the Set Up tab. Select Measurement Option, Lane
Option, and Channels.

Set up Switch matrix (if used) by clicking on the Switch Matrix Setup button.
Set up InfiniiSim if needed.

Type in or select the Device Identifier as well as the User Description from the
drop-down list. Enter your comments in the Comments text box.

Click the Select Tests tab and check the tests you want to run. Check the parent
node or group to check all the available tests within the group.

File View Tools Help

D@ dEl R B Ele

Task Flow _| setup SelectTests |Conﬁgure I Connectl Run Tests I Automation I Results I Html Report
e

B[] 100GBASE-KRA Tests
EIL-_| ) Main Voltage Measurements (pattern: PRESS)

----- [] © Differential Peak to Peak Output Voltage Test with TX disabled

----- []© DC Common Mode Output Voltage Test

----- []© AC Common Mode Output Voltage Test

----- [ © Differential Peak to Peak Output Voltage Test

=[] © Jitter and Signaling Rate Measurements (pattern: PRBSS)

----- []© signaling Rate

----- [0 © Even-Odd Jitter

Configure & . [] © Bounded Uncorrelated Jitter

----- []© Random Jitter

=[] © Output Waveform Measurements {pattern: PRESS)

----- [0 © Steady-State Voltage Vf

Connect | § ¢ [ Linear Fit Pulse Peak

-] © Normalized Coefficient Step Size

E-[J] O Full Scale Range Tests

B[] © Return Loss PNA/ENA Measurements

-[] © Differential Output Return Loss

[ © Common-mode Output Return Loss

) DME/EEE Waveform Measurements
8l DME Differential Peak to Peak Output Voltage Test
) DME T1-Transition Position Spacing (period) Test

() DME T2-Clock Transition to Clock Transition Test

) DME T3-Clock Transition to Data Transition Test

() EEE Differential Peak to Peak Qutput Voltage Test with TX disabled

) EEE Differential Peak to Peak Qutput Voltage Test

e () EEE Common Mode Voltage Deviation Test

SetUp

Select Tests

Run Tests

Test: DME Differential Peak to Peak Output Voltage Test

Pass Limits: 600 mV <= DME Differential Voltage <= 1.200V -
Description: Test the maximum voltage of the signal during DME E
Limit Set: IEEE 802.3 100GBASE-KR.4 Test Limit

Reference: 802.3ap-2012_KR. Spec - Section 73.5.1 Table 73-1

| 7 Tests |Ched< the test(s) you would like to run |Connecﬁon: UNKMOWN | 4

Figure 14 Selecting DME/EEE Waveform Tests
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DME/EEE Waveform Measurements 9

DME/EEE  The T0GBASE-KR DME specifications can be found in IEEE 802.3ap section 73.5.1
Waveform  Table 73-1 and section 73.5.3 Table 73-2. The T0GBASE-KR EEE specifications
Specifications  can be found in section 72.7.1 Table 72-6.

DME Differential Peak-to-Peak Output Voltage (0.6-1.2 V).

DME T1 (3.2 ns-0.01% to 3.2 ns+0.1%).

DME T2 (6.2 ns-6.6 ns).

DME T3 (3.0 ns-3.4 ns).

EEE Differential Peak-to-Peak Output Voltage with TX disabled (max 30 mV).
EEE Differential Peak-to-Peak Output Voltage with TX enabled (min 120 mV).
EEE Common Mode Voltage Deviation (+150 mV).
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DME/EEE Waveform Measurements

DME Differential Peak-to-Peak Output Voltage Test

48

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the peak-to-peak voltage of the differential
signal on a 1010 pattern is less than 1200 mV.

The differential signal max peak-to-peak voltage on a 1010 pattern is less than
1200 mV.

1
2
3
4

Obtain sample or acquire signal data.
Verify that there is a signal is connected and has a 1010 pattern.
Measure the peak-to-peak voltage of the differential signal of DUT+ and DUT-.

Compare the min and max peak-to-peak voltage to be within 0.6 to 1.2 V.
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DME/EEE Waveform Measurements 9

DME T1-Transition Position Spacing (Period) Test
The purpose of this test is to verify that transition spacing of the DME signal is
3.2 ns +0.01%.
PASS Condition  The mean period is between 3.2 ns £0.01%.

Measurement
Algorithm

Obtain sample or acquire signal data.
Verify that there is a signal is connected.

Request DUT in DME mode.

Measure the unit interval of the differential DME signal — set Ul measurement to
SEMI, 3.2e-9.

6 Compare the mean measurement to 3.2 ns +0.01%.

1
2
3 Set memory depth to capture the number or Ul set in the configuration tab.
4
5
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9  DME/EEE Waveform Measurements

DME T2-Clock Transition to Clock Transition Test

The purpose of this test is to verify clock to clock transition is 6.2 ns to 6.6 ns.
PASS Condition  The mean period is between 6.2 ns to 6.6 ns.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal is connected.

3 Set memory depth to capture the number or Ul set in the configuration tab.
4 Request DUT in DME mode.

5 Measure the rising to rising edge.

6

Compare the min and max values to measurement to 6.2 ns to 6.6 ns.
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DME/EEE Waveform Measurements 9

DME T3-Clock Transition to Data Transition Test

The purpose of this test is to verify clock to data transition is 3.0 ns to 3.4 ns.

PASS Condition  The min and max Ul time is between 3.0 ns to 3.4 ns.

Measurement
Algorithm

1
2
3
4
5

Obtain sample or acquire signal data.

Verify that there is a signal is connected.

Set memory depth to capture the number or Ul set in the configuration tab.
Request DUT in DME mode.

Measure the unit interval of the differential DME signal — set Ul measurement to
SEMI, 3.2e-9.

Compare the min and max values to measurement to 3.0 ns to 3.4 ns.
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9  DME/EEE Waveform Measurements

EEE Differential Peak-to-Peak Output Voltage Test with TX Disabled

The purpose of this test is to verify that when TX is disabled the peak-to-peak
voltage is less than 30 mV.

PASS Condition  The max peak-to-peak voltage is less than 30 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Request DUT to be EEE mode.

3 Check that the signal is truly with TX disabled (no valid data transitions).
4 Measure peak-to-peak voltage of the signal.

5 Compare the max peak-to-peak voltage to 30 mV.
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DME/EEE Waveform Measurements 9

EEE Differential Peak-to-Peak Output Voltage Test

The purpose of this test is to verify that the peak-to-peak voltage of the differential
signal on a 1010 pattern is greater or equal to 720 mV.

PASS Condition  The differential signal max peak-to-peak voltage on a 1010 pattern is greater than
or equal to 720 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Request DUT in EEE mode.

3 \Verify that there is a signal is connected and has a 1010 pattern.

4 Measure the peak-to-peak voltage of the differential signal of DUT+ and DUT-.
5 Compare the min voltage to be greater than or equal to 720 mV.
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DME/EEE Waveform Measurements

EEE Common Mode Deviation Voltage Test

b4

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the common mode signal of the differential
pair of the pre-LPI signal and the LPI signal is within £150 mV.

The signal voltage change between pre and post LPI is within 150 mV change.

1
2
3
4

(3]

Obtain sample or acquire signal data.
Verify that there is a signal and that the connection is dual-single ended.
Request DUT to be pre-LPl.

Measure the peak-to-peak voltage of the addition of the channel 1 and 3 or
channel 2 and 4.

Request DUT to be in LPI.

Measure the peak-to-peak voltage of the addition of the channell and 3 or
channel 2 and 4.

Calculate Vpp(post)-Vpp(pre).
Compare the result from step 8 to £150 mV.
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KEYSIGHT

TECHNOLOGIES

Keysight N8829A T00GBASE-KR4 Compliance Test Application
Methods of Implementation

Debug Mode

Debug mode can be selected to make enable the ability to change jitter
measurement options. In the Configuration tab, select the Debug radio button. This
will add the following options:

Rj Bandwidth — Choose the Rj Filter. Options are Narrow (Pink) or Wide (White).
This changes the amount of DC jitter in the Rj measurement.

Jitter Pattern Length — Choose Periodic or Arbitrary. Periodic is used for data
patterns that are periodic and repeat through the scope memory. Arbitrary is
used for random data patterns or long data patterns (for example, PRBS31)
that do not repeat through the scope memory. If Arbitrary is selected, set the ISI
filters.

ISI Filter Lead — \When using Arbitrary mode for the Jitter Pattern Length, set the
Leading ISI filter coefficient. To help select the correct IS filter, see Application
Note 1574: Choosing the ISI Filter Size for EZJIT Plus Arbitrary Data Jitter
Analysis (at www.keysight.com, literature part number 5989-4974EN).

ISI Filter Lag — When using Arbitrary mode for the Jitter Pattern Length, set the
Lagging ISl filter coefficient. Again, to help select the correct IS filter, see
Application Note 1574: Choosing the ISI Filter Size for EZJIT Plus Arbitrary
Data Jitter Analysis.

bb


http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf

10 Debug Mode

b6 Keysight N8829A T00GBASE-KR4 Compliance Test Application Methods of Implementation
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A Calibrating the Infiniium
Oscilloscope and Probe

Oscilloscope Internal Calibration / 58
Probe Calibration / 63

This section describes the Keysight Infiniium digital storage oscilloscope
calibration procedures.

KEYSIGHT

TECHNOLOGIES

57



A Calibrating the Infiniium Oscilloscope and Probe

Oscilloscope Internal Calibration

This will perform an internal diagnostic and calibration cycle for the oscilloscope.
For the Keysight oscilloscope, this is referred to as Calibration.

Required Equipment for Oscilloscope Calibration

To calibrate the Infiniium oscilloscope in preparation for running the automated
tests, you need the following equipment:

Keyboard, gty = 1, (provided with the Keysight Infiniium oscilloscope).
Mouse, gty = 1, (provided with the Keysight Infiniium oscilloscope).

Precision 3.5 mm BNC to SMA male adapter, Keysight p/n 54855-67604,
gty = 2 (provided with the Keysight Infiniium oscilloscope).

Calibration cable (provided with Keysight Infiniium oscilloscopes). Use a good
quality 50 Q BNC cable.

BNC shorting cap.

BNC

Shorting Cap
(Used to calibrate
54850A series
oscilloscopes)

\ .
Precision 3.5 mm Adapters (2)

\

Calibration Cable
(Used to calibrate 54850A,
Keysight Infiniium
oscilloscopes)

Figure 15 Accessories Provided with the Keysight Infiniium Oscilloscope
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Calibrating the Infiniium Oscilloscope and Probe A

Running the Oscilloscope Internal Calibration

This Calibration will take about 20 minutes. Perform the following steps:

1 Set up the oscilloscope with the following steps:

a

Connect the keyboard, mouse, and power cord to the rear of the
oscilloscope.

Plug in the power cord.

Turn on the oscilloscope by pressing the power button located on the lower
left of the front panel.

Allow the oscilloscope to warm up at least 30 minutes prior to starting the
calibration procedure in step 3 below.

2 Locate and prepare the accessories that will be required for the internal
calibration:

a
b

c

Locate the BNC shorting cap.
Locate the calibration cable.
Locate the two Keysight precision SMA/BNC adapters.

Attach one SMA adapter to the other end of the calibration cable - hand
tighten snugly.

Attach another SMA adapter to the other end of the calibration cable - hand
tighten snugly.

Keysight N8829A TO0GBASE-KR4 Compliance Test Application Methods of Implementation 59



A Calibrating the Infiniium Oscilloscope and Probe

3 Referring to the following figure, perform the following steps:
a Click the Utilities > Calibration... menu to open the Calibration dialog box.

File Control Setup Measure Analyze BUEINEESN Help 9:26 AM

Calibration...

20.0 GSa/s 2.00 Mpts i Self Test... I ©GHz Reduced BW

eGUL..

GPIB Setup...
Web Control...
LXI Lan Setup...

Install Option License...

User Preferences...
Waveform Report Wizard

i eleme x| o - O o o

Source Vertical Scale Offset Horizontal Scale Position

Figure 16 Accessing the Calibration Menu

4 Referring to the following figure, perform the following steps to start the
calibration:
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Calibrating the Infiniium Oscilloscope and Probe

A

AL Calibration Status:
Probe Comp ~ Calibration ATemp:

Calibration Date:
Time Scale Cal ATemp:
Time Scale Cal Date:

W Cal Memaory Protect

Callbrated

-5°C

31 JJL 2006 11:15:41
0°C

21 APR 2006 13:12:33

Start

Calibration Status

Common Passed

Chanrel Wertical Trigger
1 Passed Passed
2 Passed Passed
3 Passed Passed
4 Passed Passed

Aux Passed

I™ Detalls

Probe calibration is accessed via the Channel Dialogs

Figure 17 Oscilloscope Calibration Window

a Uncheck the Cal Memory Protect checkbox.
b Click the Start button to begin the calibration.

Close
o | x|

¢ During the calibration of channel 1, if you are prompted to perform a Time

Scale Calibration, as shown in the following figure, click the Std+Dflt button to

continue the calibration, using the Factory default calibration factors.
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Calibrating the Infiniium Oscilloscope and Probe

Calibration Options

Standard Calibration Std

Standard Calibration + Time Scale Calibration.  This requires an accurate 10MHz source. St + T

This should be performed once per year. s

Standard Calibration + Reset Time Scale Calibration to factary settings. St + DAt
Help

Figure 18 Time Scale Calibration Dialog Box

d When the calibration procedure is complete, you will be prompted with a
Calibration Complete message window. Click the OK button to close this
window.

e Confirm that the Vertical and Trigger Calibration Status for all Channels
passed.

f Click the Close button to close the calibration window.
g Theinternal calibration is completed.

These steps do not need to be performed every time a test is run. However, if the ambient
temperature changes more than 5 degrees Celsius from the calibration temperature, this
calibration should be performed again. The delta between the calibration temperature and the
present operating temperature is shown in the Utilities > Calibration... menu.
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Calibrating the Infiniium Oscilloscope and Probe A

Probe Calibration

Before performing the automated tests, you should calibrate the probes.
Calibration of the solder-in probe heads consist of a vertical calibration and a skew
calibration. The vertical calibration should be performed before the skew
calibration. Both calibrations should be performed for best probe measurement

performance.
Required Equipment for Probe Calibration

The calibration procedure requires the following parts.
BNC (male) to SMA (male) adapter.
Deskew fixture.
50 Q SMA terminator.

Connecting the Probe for Calibration

For the following procedure, refer to the following figure.
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Calibrating the Infiniium Oscilloscope and Probe

BNC to SMA
Connector

Pincher

Deskew . s 00 00 02— :

Fixture /

50 Q SMA / 

Terminator

Figure 19  Solder-in Probe Head Calibration Connection Example

1 Connect BNC (male) to SMA (male) adapter to the deskew fixture on the
connector closest to the yellow pincher.

2 Connect the 50 Q@ SMA terminator to the connector farthest from yellow
pincher.

Keysight N8829A TO0GBASE-KR4 Compliance Test Application Methods of Implementation



Calibrating the Infiniium Oscilloscope and Probe A

Connect the BNC side of the deskew fixture to the Aux Out BNC of the Infiniium
oscilloscope.

Connect the probe to an oscilloscope channel.

To minimize the wear and tear on the probe head, it should be placed on a
support to relieve the strain on the probe head cables.

Push down the back side of the yellow pincher. Insert the probe head resistor
lead underneath the center of the yellow pincher and over the center conductor
of the deskew fixture. The negative probe head resistor lead or ground lead
must be underneath the yellow pincher and over one of the outside copper
conductors (ground) of the deskew fixture. Make sure that the probe head is
approximately perpendicular to the deskew fixture.

Release the yellow pincher.

Verifying the Connection

1
2
3
4

Delete

[Taf2)

On the Infiniium oscilloscope, press the [Auto Scale] key on the front panel.
Set the volts per division to 100 mV/div.
Set the horizontal scale to 1.00 ns/div.

Set the horizontal position to approximately 3 ns. You should see a waveform
similar to that in the following figure.

File Control  Setup  Measure  Analyze  Utlites  Help 12:24 Phd

All

Eﬂ@l@l [H]

Figure 20 Good Connection Waveform Example

If you see a waveform similar to that of the following figure, then you have a bad

C

onnection and should check all of your probe connections.

Keysight N8829A T00GBASE-KR4 Compliance Test Application Methods of Implementation 65



A Calibrating the Infiniium Oscilloscope and Probe

12:21 PM.

Liilities  Help

Analyze

Measure

Contral ~ Setup

File

[Taf2)

Delete
All

Figure 21 Bad Connection Waveform Example
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Running the Probe Calibration and Deskew

Calibrating the Infiniium Oscilloscope and Probe A

1 On the Infiniilum oscilloscope in the Setup menu, select the channel connected

to the probe, as shown in the following figure.

g 1 Channel 1...
@ Eechannel Zoon
'Channel &b
'Channel 4..

[ElHorizontal...

Trigger...
Trigger Shortcuts

InfiniiScan...

Acquisition...
Display...

waveform Memories...

Source Vertical Scale 0Offset

File Control Measure Analyze Utilities Help

Ctrl+1
Ctrl+2
Ctrl+3
Ctri+4

Ctrl+H
Ctri+T

Ctrl+I

Ctri+A
Ctrl+D

Alt+M

Figure 22 Channel Setup Window

8GHz Reduced BW

Horizontal Scale Position

2 Inthe Channel Setup dialog box, select the Probes... button, as shown in the

following figure.
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A Calibrating the Infiniium Oscilloscope and Probe

Channel Setup E

0000

ron - Close
Scale =l ﬂ
540 M/ %‘

Offset

00V ﬁ

Skew

00s 4/0(»

Labels Probes... |

ron It =l Trigger...

Figure 23 Channel Dialog Box

3 In the Probe Setup dialog box, select the Calibrate Probe... button.

Probe Setup =
(1 FEEEN @ 1150 I. uson  |@noprobe |
Configure Prabing System ‘ Calibrate Probe. .. ‘ Close

Help | k?

Head Label (Type) = 1169A Probe Amplifier
. - Serial #: US44001124
Head1 (N5381A:0F Sldr Berdwidt: 12.0 Gz

$= Add Head... | Edit Head... | =
Probe System

Calibration Status
Atten Cal: Uncalibrated
Skew Cal: Uincalibrated
Aftenuation:  3.3:1

Signal being prabed
« single-Ended

« Differential

Character|stics
Head1 Bandwidth: 12.0 GHz
Model: N5381A Resistance: 50.0 ke
Diff Solder-In Capacitance: 210.0 fF

Max Input: £30.0Y
Dvnrange: £1.7 W
CMrange: £8.0V

SE offset range: £16.0%

Figure 24 Probe Setup Window

4 Inthe Probe Calibration dialog box, select the Calibrated Atten/Offset radio
button.

5 Select the Start Atten/Offset Calibration... button and follow the on-screen
instructions for the vertical calibration procedure.
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Probe Calibration

Please allow 15 minutes for probe
warmup before starting calibration.

Aftenuation/Offset Calibration Value
« Default Atten/Offset
& Calibrated Atten/Offset

Start Atten/Offset Calibration... ‘

(1 FEEEN @ 1150 I. weon | @ o probe

Skew Callbration Value
& Default Skew

C Mo Skew
 Calibrated Skew

Calibrating the Infiniium Oscilloscope and Probe

l

Close

Head Label (Type) 1169A Probe Amplifier
Head! (MS381ADF Siar ~ | [Attached Head: Head1 (N5381A:Diff Solder-In)

Atten/Offset Calibration Status

Default Atten 3.3:1
Calibrated Atten Mot Calibrated (Using default values)

Skew Calibration Status

Mot Calibrated (Using default skew)

Figure 25 Probe Calibration Window

6 Once the vertical calibration has successfully completed, select the Calibrated

Skew... button.

A

7 Select the Start Skew Calibration... button and follow the on-screen instructions
for the skew calibration.

At the end of each calibration, the oscilloscope will prompt you if the calibration
was or was not successful.

Verifying the Probe Calibration

If you have successfully calibrated the probe, it is not necessary to perform this

verification. However, if you want to verify that the probe was properly calibrated,
the following procedure will help you verify the calibration.

The calibration procedure requires the following parts:
BNC (male) to SMA (male) adapter.
SMA (male) to BNC (female) adapter.

BNC (male) to BNC (male) 12 inch cable such as the Keysight 8120-1838.

Keysight 54855-61620 calibration cable (Infiniium oscilloscopes with
bandwidths of 6 GHz and greater only).

Keysight 54855-67604 precision 3.5 mm adapters (Infiniium oscilloscopes with

bandwidths of 6 GHz and greater only).

Deskew fixture.

For the following procedure, refer to the following figure.
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Calibrating the Infiniium Oscilloscope and Probe

BNC to SMA
Connector

Pincher

Deskew . s 00 00 02— :

Fixture /

50 Q SMA / 

Terminator

Figure 26 Probe Calibration Verification Connection Example

1 Connect BNC (male) to SMA (male) adapter to the deskew fixture on the
connector closest to the yellow pincher.

2 Connect the SMA (male) to BNC (female) to the connector farthest from the
yellow pincher.

Keysight N8829A TO0GBASE-KR4 Compliance Test Application Methods of Implementation



Calibrating the Infiniium Oscilloscope and Probe A

3 Connect the BNC (male) to BNC (male) cable to the BNC connector on the
deskew fixture to one of the unused oscilloscope channels. For infiniium
oscilloscopes with bandwidths of 6 GHz and greater, use the 54855-61620
calibration cable and the two 54855-64604 precision 3.5 mm adapters.

4 Connect the BNC side of the deskew fixture to the Aux Out BNC of the Infiniium
oscilloscope.

5 Connect the probe to an oscilloscope channel.

6 To minimize the wear and tear on the probe head, it should be placed on a
support to relieve the strain on the probe head cables.

7 Push down on the back side of the yellow pincher. Insert the probe head
resistor lead underneath the center of the yellow pincher and over the center
conductor of the deskew fixture. The negative probe head resistor lead or
ground lead must be underneath the yellow pincher and over one of the outside
copper conductors (ground) of the deskew fixture. Make sure that the probe
head is approximately perpendicular to the deskew fixture.

8 Release the yellow pincher.
9 On the oscilloscope, press the autoscale button on the front panel.

10 Select Setup menu and choose the channel connected to the BNC cable from
the pull-down menu.

11 Select the Probes... button.

12 Select the Configure Probe System button.

13 Select User Defined Probe from the pull-down menu.

14 Select the Calibrate Probe... button.

15 Select the Calibrated Skew radio button.

16 Once the skew calibration is completed, close all dialog boxes.

17 Select the Start Skew Calibration... button and follow the on-screen instructions.
18 Set the vertical scale for the displayed channels to 100 mV/div.

19 Set the horizontal range to 1.00 ns/div.

20 Set the horizontal position to approximately 3 ns.

21 Change the vertical position knobs of both channels until the waveforms
overlap each other.

22 Select the Setup menu choose Acquisition... from the pull-down menu.

23 In the Acquisition Setup dialog box enable averaging. When you close the
dialog box, you should see waveforms similar to that in the following figure.
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Liilities  Help

Analyze

Measure

Setup

File

Contral

More
[2af2)

Delete
All

Figure 27 Calibration Probe Waveform Example

Each probe is calibrated with the oscilloscope channel to which it is connected. Do not switch
probes between channels or other oscilloscopes, or it will be necessary to calibrate them
again. It is recommended that the probes be labeled with the channel on which they were

calibrated.
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Numerics

100GBASE-KR4 compliance test
application, 3

A

AC Common Mode Output Voltage Test, 19
application software, installing, 8
application software, starting, 13
Automation tab, 14

B

BNC shorting cap, 58
BNC to SMA male adapter, 58
bounded uncorrelated jitter, 25

C

calibrating the oscilloscope, 12,57
calibration cable, 58

Configure tab, 14

Connect tab, 14

copyright, 2

D

data rate, 24

data rate and jitter measurements, 21

DC Common Mode Output Voltage Test, 18

Debug Mode, 55

deskew and probe calibration, running, 67

Differential Peak-to-Peak Output Voltage
Test, 20

Differential Peak-to-Peak Output Voltage
Test with TX Disabled, 17

DME Differential Peak-to-Peak Output
Voltage Test, 48

DME T1-Transition Position Spacing (Period)
Test, 49

DME T2-Clock Transition to Clock Transition
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DME T3-Clock Transition to Data Transition
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DME/EEE waveform measurements, 45

DME/EEE waveform specifications, 47
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EEE Common Mode Deviation Voltage
Test, 54

EEE Differential Peak-to-Peak Output
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EEE Differential Peak-to-Peak Output
Voltage Test with TX Disabled, 52
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equipment required for probe
calibration, 63

even-odd jitter, 25

F

full scale range measurements, 39

H

HTML Report tab, 14

installation, 7
ISI Filter Lag, 55
ISI Filter Lead, 55

J

jitter, 25
jitter and data rate measurements, 21
Jitter Pattern Length, 55

K

keyboard, 58

license key, installing, 9
Linear Fit Pulse Peak, 28

M

main voltage measurements, 15

main voltage specifications, 16
measurements, preparing, 11

Minimum Post-cursor Full-scale Test, 42
Minimum Pre-cursor Full-scale Test, 41
mouse, 58

N

Normalized Coefficient Step Size c(1) dec
c(0) hold c(-1) hold, 33

Normalized Coefficient Step Size c(1) hold
c(0) dec c(-1) hold, 35

Normalized Coefficient Step Size c(1) hold
c(0) hold ¢(-1) dec, 37

Normalized Coefficient Step Size c(1) hold
c(0) hold c(-1) inc, 36

Normalized Coefficient Step Size c(1) hold
c(0) inc c(-1) hold, 34

Normalized Coefficient Step Size c(1) inc
¢(0) hold c(-1) hold, 32

normalized coefficient step size
measurements, 29

notices, 2

0

oscilloscope calibration, 12

oscilloscope internal calibration, 58

oscilloscope internal calibration,
running, 59

P

precision 3.5 mm BNC to SMA male
adapter, 58

probe calibration, 63

probe calibration and deskew, running, 67

probe calibration connection, verifying, 65

probe calibration, connecting, 63

probe calibration, verifying, 69

R

random jitter, 25
Results tab, 14
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Rj Bandwidth, 55
Run Tests tab, 14

S

Select Tests tab, 14

Set Up tab, 14

specifications, DME/EEE waveform, 47
specifications, main voltage, 16
specifications, transmitter output, 22, 26
Steady State Voltage Vf, 27

T

transmitter output specifications, 22, 26
transmitter output waveform
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W

warranty, 2
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